GMPLS UNI for Packet and Optical Integration
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GMPLS UNI

Generalized Multiprotocol Label Switching User Network Interface (GMPLS UNI) is a control plane technology
that

* enables packet networks to interact directly with the optical transport control plane,
* coordinates packet network resource requirements with the optical transport network, and

* uses open standards to optimize network resource use across packet and optical domains.
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Table 1: Feature History
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Feature Name

Release Information

Feature Description

GMPLS UNI Support for OTN-XP
and 2-QDD-C Cards

Cisco IOS XR Release 7.10.1

Generalized Multiprotocol Label
Switching (GMPLS) User Network
Interface (UNI) support is enabled
for OTN-XP and 2-QDD-C cards
in NCS 1004. GMPLS UNI helps
in optimizing the utilization of
network resources.

For OTN-XP card the following
data paths are allowed.

* 2x100 - 200G MXP
* 4x100 - 400G MXP
* 40x10 - 400G MXP
» 20x10 - 200G MXP

For 2-QDD-C card only
200G/300G/400G trunk rates are
allowed with 100GE or OTU4
client payloads in both the
muxponder and muxponder slice
configurations.

Packet and optical integration

As cloud services become central to business operations, packet and optical network services must evolve to
be more efficient and dynamic. Closer integration of packet and optical networks is critical, especially in the
control plane. GMPLS UNI is a key enabling technology that supports this integration.

Channel spacing

The Dense Wavelength Division Multiplexing (DWDM) grid in the C-band (1530-1569 nm) of the optical
spectrum is divided into multiple channels so that each channel can carry traffic independently. The number
of channels available from the DWDM grid depends on the channel spacing: lower channel spacing yields
more channels, and higher channel spacing yields fewer channels.

GMPLS supports two types of channel spacing.

* Fixed grid channel spacing: The channel spacing is fixed at 50 GHz and supports 100 Gbps and 200

Gbps traffic.

* Flexible grid channel spacing: The channel spacing is 6.25 GHz and supports all data rates. The channels
are divided into finer slices so that the channel width can be defined as a multiple of these slices to fit
the data bandwidth requirement.

NCS 1004 supports only flexible grid channel spacing.

The neighbor flexi-grid-capable command enables GMPLS UNI flexible grid channel spacing. This
command is run during the LMP configuration.
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GMPLS UNI tunnels

GMPLS UNI tunnels are end-to-end optical paths between two NCS 1004 nodes that

* connects two nodes,

» efficiently uses the Dense Wavelength Division Multiplexing (DWDM) grid with minimal wastage of
spectral bandwidth, and

* carries mixed bit-rate or mixed modulation data in a flexible grid using different channel widths.

To address common packet and optical network requirements, you create a tunnel between two NCS 1004
nodes to carry traffic by using GMPLS UNI technology, as shown in the following figure.

Figure 1: GMPLS UNI reference model
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UNI-C is the client, packet, or router node, for example, an NCS 1004 node. UNI-N is the network or optical
node, for example, an NCS 2000 node.

A Link Management Protocol (LMP) link is created to establish connectivity between an NCS 2000 node and
an NCS 1004 node. The tunnel is then created between the trunk interfaces of the source and destination NCS
1004 nodes to carry traffic. When the tunnel is created between NCS 1004 nodes, a circuit is internally created
between the NCS 2000 nodes to perform path computation, restoration, and reversion functions.

The tunnel can be created between the source and destination NCS 1004 nodes without involving NCS 2000
nodes in the middle. However, restoration and reversion capabilities are provided only by NCS 2000 nodes
that use GMPLS UNI.

Licensing and configuration prerequisites for GMPLS UNI tunnels

Ensure that all necessary software packages, licenses, network reachability, and operational port conditions
are met on NCS 1002, NCS 1004, and NCS 2000 nodes before creating a tunnel using Generalized Multiprotocol
Label Switching User Network Interface (GMPLS UNI), enabling successful tunnel deployment and operation.

Before you create a tunnel by using GMPLS UNI, ensure that the following prerequisites are met.

* The NCS 1004 node has both the MPLS and MPLS-TE packages installed. The package names are
ncs1004-mpls and ncs1004-mpls-te-rsvp.

» The NCS 2000 node has a valid license for ROADM and Wavelength Switched Optical Network (WSON)
support.

» The management IP addresses of the NCS 1004 and NCS 2000 nodes are reachable.

* The administrative state of the trunk port of the optics controller on the NCS 1004 node is not in the
shutdown state.
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. Limitations for a GMPLS UNI tunnel

Limitations for a GMPLS UNI tunnel

This reference enables you to accurately identify the supported trunk port types and software release restrictions
for GMPLS UNI tunnels on NCS 1002 nodes, ensuring compliant and optimized tunnel configuration.

The following limitations apply when you create a GMPLS UNI tunnel.

Configuration workflow for a GMPLS UNI tunnel

Summary
Creating a GMPLS UNI tunnel involves the following actors.

* NCS 2000 node (UNI-N): Provides the optical transport network and runs the Link Management Protocol
(LMP) endpoint, alien wavelength, and ifindex provisioning.

* NCS 1004 node (UNI-C): Acts as the client router that runs LMP, Resource Reservation Protocol (RSVP),
and the MPLS traffic-engineering tunnel toward the destination node.

You complete the NCS 2000 node configuration first, then configure the source and destination NCS 1004
nodes to bring up the tunnel.

Workflow
These stages describe the GMPLS UNI tunnel configuration workflow.
1. On the NCS 2000 node, perform the following configurations:
* Configure LMP and alien wavelength on the NCS 2000 node by using CTC.

 Retrieve ifindex from the NCS 2000 node.

2. On the NCS 1004 node, perform the following configurations:
* Configure LMP on the Cisco NCS 1002 or NCS 1004 node.

* Configure the MPLS tunnel on the NCS 1002 or NCS 1004 node.
* Configure RSVP on the NCS 1002 or NCS 1004 node.

Result

The GMPLS UNI tunnel is established between the source and destination NCS 1004 nodes, with the optical
path computed by the NCS 2000 nodes.

Configure an LMP link and Alien Wavelength on an NCS 2000 node using CTC for signaled numbered

circuit

Establish connectivity and enable advanced opUse this task to set up a static LMP link between a Cisco NCS
2000 node and either an NCS 1004 node. The CTC LMP creation wizard enables you to select source and
destination endpoints, configure optical parameters, and set alien wavelength options. tical parameters and
alien wavelength configurations for signaled numbered circuits between Cisco optical network nodes.
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Configure an LMP link and Alien Wavelength on an NCS 2000 node using CTC for signaled numbered circuit .

Use this task to set up a static LMP link between a Cisco NCS 2000 node and either an NCS 1002 or NCS
1004 node. The CTC LMP creation wizard enables you to select source and destination endpoints, configure
optical parameters, and set alien wavelength options.

Procedure

Step 1 From the View menu, choose Go to Network View.
Step 2 Click the Provisioning > LMP tabs.
Step 3 Click Create.

The LMP Creation window appears.

Step 4 Click Signaled in the Router Not Managed by CTC area.
A wizard appears with the following options:

LMP Origination, LMP Termination, Optical Parameters, and Alien Wavelength

Step 5 In the LMP Origination screen of the wizard, provision these parameters:
* From the Originating Node drop-down list, choose the source node of the LMP.

If the source node is Cisco NCS 1004, the destination node must be MSTP, and the other way round.
* From the Local | nterfaces drop-down list, choose an available interface.
* Choose the Type, Shelf, Slot, and Port for Ingress Port Selection and Egress Port Selection.
* Choose Numbered interface.
* Enter the IP address of the source node in the Interface | P field.

* Set the mode of revertive restoration to either UNI-C or UNI-N. If the mode is set to UNI-C, the reversion of the
circuit from the restored path to the original path is initiated by the UNI client that is connected to NCS 1004. If the
mode is set to UNI-N, the reversion of the circuit is initiated by the DWDM network and can either be a manual
revert or an auto revert.

* Enter the RSVP signaling interval and RSVP signaling missed values in the respective fields.
* Click Next.

Step 6 In the LMP Termination screen of the wizard, provision these parameters:

* From the Terminating Node drop-down list, choose the destination node of the LMP; for example, MSTP node.

* From the Rx Port Selection area, perform the following.

* Choose the card type from the Type drop-down list.
* Choose a shelf from the Shelf drop-down list.
* Choose a source slot from the Slot drop-down list

* Choose a port from the Port drop-down list.

* From the Tx Port Selection area, perform the following.
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. Configure an LMP link and Alien Wavelength on an NCS 2000 node using CTC for signaled numbered circuit

* Choose the card type from the Type drop-down list.
* Choose a shelf from the Shelf drop-down list.
* Choose a destination slot from the Slot drop-down list.

* Choose a port from the Port drop-down list

« Enter the IP address of the destination node in the I nterface | P field.

* Set the mode of revertive restoration to either UNI-C or UNI-N. If the mode is set to UNI-C, the reversion of the
circuit from the restored path to the original path is initiated by the UNI client that is connected. If the mode is set
to UNI-N, the reversion of the circuit is initiated by the DWDM network and can be either a manual revert or an
auto revert.

* Enter the remote Ifindex of NCS 1004 node (in decimals) in the Remote If Index field.

» Click Next.

Step 7 In the Optical Parameters screen of the wizard, provision these parameters:

« Allow Regeneration—When checked, the computed path traverses through the regeneration site only if the optical
validation is not satisfied. You can regenerate a circuit that is created from the UNI interface. If a transparent path
is feasible, the regenerator is not used.

* UNI State—Choose Enable or Disable from the UNI State drop-down list.

The Enable state is used to configure the UNI interface for the circuits to pass through, between the router and the
DWDM node. In the Disable state, the interface is configured but not active, and so the circuit activation is rejected.
When the status is changed from Enable to Disable, all active circuits on the interface are deleted.

» Description—Enter the description of the UNI interface. The description can be up to 256 characters.
« Label—Enter an alphanumeric string. This label is a unique circuit identifier.

» Validation—Sets the optical validation mode.

¢ Full—The circuit is created when the circuit validation result is greater than or equal to the acceptance threshold
value.

* None—The circuit is created without considering the acceptance threshold value. The Opt Valid column in the
Circuits tab displays the value as Not Valid.

¢ Inherited—The restoration circuit inherits the validation and acceptance threshold values from the primary
circuit.

» Acceptance threshold—sSets the acceptance threshold value for the GMPLS circuit. The circuit is created if the
actual acceptance threshold value is greater than, or equal to, the value set in this field.

* Green—Indicates that the channel failure risk is 0%.
 Yellow—Indicates that the channel failure risk is between 0% and 16%.
» Orange—Indicates that the channel failure risk is between 16% and 50%.

* Red—Indicates that the channel failure risk is greater that 50%.

» Restor ation—Check this check box to enable the restoration of the GMPLS circuits on the UNI interface.
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Step 9
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Configure an LMP link with Alien Wavelength on NCS 2000 using CTC for signaled unnumbered circuits .

» Revert—Check this check box to enable the revert of the GMPLS circuits on the UNI interface.

» Auto Revert—Click this radio button to automatically revert the circuit from the restored path to the original path
after the failure is fixed, WSON alarms are acknowledged, and the soak time expires.

» Manual Revert—Click this radio button to manually revert the circuit from the restored path to the original path
after the failure is fixed, the WSON alarms are acknowledged, and the soak time expires.

» Soak Time—Enter the time (in hours, minutes, and seconds) in the Soak Time field that the circuit on the restored
path waits before moving to the original path after the failure is fixed. The circuit reverts to the original path after
the soak time expires. The soak time must be set only if both the Restoration and Revert check boxes are checked.

Click Next.

In the Alien wavelength screen of the wizard, provision these parameters.
* From the Alien Wavelength drop-down list, choose the alien wavelength class.

* From the Trunk Selection drop-down list, choose 100G, 200G, or 250G.

* From the FEC drop-down list, choose a valid value for forward error correction (FEC) mode. If an invalid FEC
value is chosen, LMP link is created; however, the circuit creation fails.

» Click Finish to create an LMP link.

The LMP link with specified optical parameters and alien wavelength settings is created and listed in CTC,
ready for signaled numbered circuit provisioning.

Configure an LMP link with Alien Wavelength on NCS 2000 using CTC for signaled unnumbered

circuits

Step 1
Step 2
Step 3

Step 4

Step 5

Establish connectivity between NCS 2000 and NCS 1002/1004 nodes using a signaled, unnumbered LMP
link with Alien Wavelength support.

Use the LMP creation wizard in Cisco Transport Controller (CTC) to provision link parameters, optical
settings, and Alien Wavelength options for interoperability between managed and unmanaged router nodes.

Procedure

From the View menu, choose Go to Network View.
Click the Provisioning > LM P tabs.
Click Create.

The LMP Creation window appears.

Click Signaled in the Router Not Managed by CTC area.
A wizard appears with options for LMP Origination, LMP Termination, Optical Parameters, and Alien Wavelength

On the LMP Origination screen, provision these parameters:

* From the Originating Node drop-down list, choose the source node of the LMP.
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. Configure an LMP link with Alien Wavelength on NCS 2000 using CTC for signaled unnumbered circuits

* From the Local | nterfaces drop-down list, choose an available interface.

* Choose the Type, Unit, and Port for Ingress Port Selection and Egress Port Selection.
* Choose Unnumbered interface.

* The IP address of the source node selected appears in the | P field.

* Set the mode of revertive restoration to UNI-N. If the mode is set to UNI-N, the reversion of the circuit is initiated
by the DWDM network and can either be a manual revert or an auto revert.

* Click Next.

Step 6 On the LMP Termination screen of the wizard, provision these parameters:
* From I nterfaces Configuration:
Enter the NCS 1004 system IP address in the System IP field.
* Enter the IP address of the source node in the Communication Channel field.
* Enter the SNMP Ifindex value of optic trunk in the Remote I f Index field.
* Click Next.

Step 7 In the Optical Parameters screen of the wizard, provision these parameters:

+ Allow Regeneration—When checked, the computed path traverses through the regeneration site only if the optical
validation is not satisfied. You can regenerate a circuit that is created from the UNI interface. If a transparent path
is feasible, the regenerator is not used.

* UNI State—Choose Enable or Disable from the UNI State drop-down list.

The Enable state is used to configure the UNI interface for the circuits to pass through, between the router and the
DWDM node. In the Disable state, the interface is configured but not active, and so the circuit activation is rejected.
When the status is changed from Enable to Disable, all active circuits on the interface are deleted.

* Description—Enter the description of the UNI interface like Signal Unnumb LMP. The description can be up to
256 characters.

* Label—Enter an alphanumeric string. This label is a unique circuit identifier.
« Validation—Sets the optical validation mode.

* Full—The circuit is created when the circuit validation result is greater than or equal to the acceptance threshold
value.

* None—The circuit is created without considering the acceptance threshold value. The Opt Valid column in the
Circuits tab displays the value as Not Valid.

* Inherited—The restoration circuit inherits the validation and acceptance threshold values from the primary
circuit.

« Acceptance Threshold—Sets the acceptance threshold value for the GMPLS circuit. The circuit is created if the
actual acceptance threshold value is greater than, or equal to, the value set in this field.

¢ Green—Indicates that the channel failure risk is 0%.

* Yellow—Indicates that the channel failure risk is between 0% and 16%.
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Retrieve ifindex from the NCS 2000 node .

* Orange—Indicates that the channel failure risk is between 16% and 50%.

* Red—Indicates that the channel failure risk is greater than 50%.

» Restor ation—Check this check box to enable the restoration of the GMPLS circuits on the UNI interface.
» Revert—Check this check box to enable the revert of the GMPLS circuits on the UNI interface.

 Auto Revert—Click this radio button to automatically revert the circuit from the restored path to the original path
after the failure is fixed, WSON alarms are acknowledged, and the soak time expires.

» Manual Revert—Click this radio button to manually revert the circuit from the restored path to the original path
after the failure is fixed, the WSON alarms are acknowledged, and the soak time expires.

» Soak Time—Enter the time (in hours, minutes, and seconds) in the Soak Time field that the circuit on the restored
path waits before moving to the original path after the failure is fixed. The circuit reverts to the original path after
the soak time expires. The soak time must be set only if both the Restoration and Revert check boxes are checked.

Step 8 Click Next.

Step 9 In the Alien wavelength screen of the wizard, provision these parameters.
* From the Alien Wavelength drop-down list, choose the alien wavelength class such as NCS 1004.

* From the Trunk Selection drop-down list, choose 100G, 200G, or 250G.

* From the FEC drop-down list, choose a valid value for forward error correction (FEC) mode. If an invalid FEC
value is chosen, LMP link is created; however, the circuit creation fails.

* Click Finish to create an LMP link.

The newly created signaled LMP unnumbered circuit link appears in the LMP table in CTC.

The LMP link between NCS 2000 and NCS 1002/1004 is established, supporting signaled unnumbered circuits
with full optical and Alien Wavelength configuration.

Retrieve ifindex from the NCS 2000 node

You can retrieve the ifindex value of all the LMP ports of the NCS 2000 node by using the Cisco Transport
Controller (CTC) or the TL1 interface. Use this value in the neighbor interface-id unnumbered command
during the LMP configuration on the NCS 1004 node.

Procedure

Retrieve the ifindex by using either CTC or TLI.

* Touse CTC, click the Provisioning> L M P tab and read the ifindex value, in decimal format, under the Originating
I nterface Index column.

» Touse TL1, log in to the TL1 interface and run the rtrv-unicfg::all:1; command. The command returns the ifindex
of all the LMP ports of the NCS 2000 node in hexadecimal format. Convert the value to decimal format before you
use it as the remote ifindex of the NCS 1004 node.

The following sample TL1 output shows the ifindex of two LMP ports.
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. Configure LMP on Cisco NCS 1004 node

Example:

PSLINE-81-1-9-RX:PSLINE-81-1-9-TX,10.77.142.92,3.3.3.4,3.3.3.3,0.0.0.0, VALMODE=NONE, ADMINSTATE=UP,
RESTTYPE=REVERT, USPWROFS=0.0,

DSPWROFS=0.0, ALLOWREGEN=NO, UNICTRLMODE=CLIENT, REVERTMODE=MANUAL, SOAK=00-01-00,

RESTVALMODE=NONE, TERMINTFDX=0, ORIGINTFIDX=7£000d12, NUMBERED=TRUE, UNIMODE=GMPLS

PSLINE-81-1-10-RX:PSLINE-81-1-10-TX,10.77.142.92,4.4.4.4,4.4.4.3,0.0.0.0, VALMODE=NONE, ADMINSTATE=UP,
RESTTYPE=REVERT, USPWROFS=0.0, DSPWROFS=0.0, ALLOWREGEN=NO, UNICTRLMODE=CLIENT,
REVERTMODE=MANUAL, SOAK=00-01-00, RESTVALMODE=NONE, TERMINTFDX=0,

ORIGINTFIDX=7£000d14, NUMBERED=TRUE, UNIMODE=GMPLS

In the sample output, the ifindex of port 81-1-9 is 7£000d12 in hexadecimal and 2130709778 in decimal. The ifindex
of port 81-1-10 is 7£000d14 in hexadecimal and 2130709780 in decimal.

Configure LMP on Cisco NCS 1004 node

Step 1

Step 2

Step 3

Step 4

Step 5

Set up LMP parameters to enable proper communication and management between optical network devices
on a Cisco NCS 1004 node.

Use this task to configure trunk optics, neighbor link parameters, flexible grid capabilities, and associated
identifiers for numbered or unnumbered circuits. This configuration ensures seamless interoperability between
Cisco NCS 1004 and NCS 2000 nodes.

Procedure

Enter the LMP GMPLS optical UNI configuration mode.

Example:

RP/0/RP0/CPUO:ios#configure
RP/0/RP0O/CPUO:ios (config) #1lmp
RP/0/RPO/CPUO:ios (config-1lmp) #gmpls optical-uni

Specify the trunk optics controller.

Example:
RP/0/RP0O/CPUO:i0s (config-lmp-gmpls-uni) #controller optics 0/1/0/0

Configure the LMP neighbor name.

Example:

RP/0/RP0O/CPUO:ios (config-lmp-gmpls-cntl) #neighbor VEGA2K-Site-2 47
Specify the neighbor link ID for numbered circuit.
The neighbor link ID is the IP address of the Multiservice Transport Platform (MSTP) interface on the NCS 2000 node.

Example:
RP/0/RP0O/CPUO:ios (config-lmp-gmpls-cntl) #neighbor link-id ipv4 unicast 192.168.2.3

Enable GMPLS UNI flexible grid channel spacing.

Example:
RP/0/RP0O/CPUO:ios (config-lmp-gmpls-cntl) #neighbor flexi-grid-capable
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Step 6

Step 7

Step 8

Step 9

Configure LMP on Cisco NCS 1004 node .

Specify the neighbor optical interface ID, which is the ifindex value of the LMP port of the NCS 2000 node in decimal
format.

Example:
RP/0/RP0O/CPUO:ios (config-lmp-gmpls-cntl) #neighbor interface-id unnumbered 19

To retrieve the ifindex value, see Retrieve ifindex from the NCS 2000 node.

Set the IPCC mode to routed.

Example:
RP/0/RPO/CPUO:ios (config-lmp-gmpls-uni) #ipcc routed

Specify the neighbor router ID for GMPLS UNI, and commit the configuration.

Example:

RP/0/RPO/CPUO:ios (config-lmp-gmpls-cntl) # router-id ipv4 unicast 192.168.2.1
RP/0/RP0O/CPUO:1i0s (config-lmp-gmpls—-cntl) #commit

View the configuration.

Example:

show running-config lmp
1mp
gmpls optical-uni
controller optics0/0/0/13
neighbor NCS1K
neighbor link-id ipv4 unicast 192.168.2.3
neighbor flexi-grid-capable
neighbor interface-id unnumbered 19
link-id ipv4 unicast 192.168.2.4
|
neighbor NCS1K
ipcc routed
router-id ipv4 unicast 192.168.2.1
|

router-id ipv4 unicast 192.168.2.2
|

Mon Jul 1 14:42:46.856 IST

1mp

gmpls optical-uni
controller Optics0/0/0/0
neighbor ncslk
neighbor link-id ipv4 unicast 10.1.1.1
neighbor flexi-grid-capable
neighbor interface-id unnumbered 2130706976
link-id ipv4 unicast 10.0.1.1
|
controller Optics0/0/0/1
neighbor ncslk
neighbor link-id ipv4 unicast 10.1.3.3
neighbor flexi-grid-capable
neighbor interface-id unnumbered 2130707232
link-id ipv4 unicast 10.0.3.3
|
controller Optics0/1/0/0
neighbor ncslk
neighbor link-id ipv4 unicast 10.1.4.4
neighbor flexi-grid-capable
neighbor interface-id unnumbered 2130706964
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link-id ipv4 unicast 10.0.4.4
|
controller Optics0/1/0/1
neighbor ncslk
neighbor link-id ipv4 unicast 10.1.5.5
neighbor flexi-grid-capable
neighbor interface-id unnumbered 2130706966
link-id ipv4 unicast 10.0.5.5
|
neighbor ncslk
ipcc routed
router-id ipv4 unicast 10.127.60.48
|
router-id ipv4 unicast 10.105.57.101
|
|

show mpls traffic-eng tunnels optical-uni brief
Wed Sep 22 17:08:13.132 IST

TUNNEL NAME DESTINATION STATUS
GMPLS-UNI-Optics0/3/0/1 10.24.1.1 up
GMPLS-UNI-Optics0/0/0/1 10.34.1.1 up

Displayed 2 (of 2) heads, 0 (of 0) midpoints, 0 (of 0) tails
Displayed 2 up, 0 down, 0 recovering, 0 recovered heads

commit
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STATE
up
up

The Cisco NCS 1004 node is configured with the required LMP parameters for optical trunk and neighbor
link management, supporting both numbered and unnumbered circuits.

Configure the MPLS tunnel on the NCS 1004 node

Step 1

Step 2

Before you begin

Ensure that the administrative state of the trunk port of the optics controller on the NCS 1004 node is not in

the shutdown state.

You configure the Multiprotocol Label Switching (MPLS) traffic-engineering tunnel under the GMPLS optical
UNI controller. The destination IP address is the IP address of the optics controller on the destination NCS

1004 node.

The path option supports either an Explicit Route Object (ERO), which includes the routes to use through a
specified list of nodes, or an Exclude Route Object (XRO), which excludes routes through a specified list of

nodes.

Procedure

Enter the MPLS traffic-engineering GMPLS optical UNI configuration mode.

Example:

RP/0/RP0O/CPUO:ios#configure
RP/0/RP0O/CPUO:ios (config) #mpls traffic-eng
RP/0/RP0O/CPUO:ios (config-mpls-te) #gmpls optical-uni

Specify the optics controller.
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Configure RSVP on the NCS 1004 node .

Example:

RP/0/RP0O/CPUO:ios (config-te-gmpls-uni) #controller optics 0/0/0/6

Step 3 Enter the tunnel-properties submode and set the tunnel ID.

Example:

RP/0
RP/0/RP0/CPUO:i0s (config-te-gmpls-cntl) #tunnel-properties
RP/0/RP0/CPUO:i0s (config-te-gmpls-tun) #tunnel-id 100

Step 4 Specify the destination IP address of the optics controller on the destination NCS 1004 node.

Example:

R
RP/0/RP0O/CPUO:ios (config-te-gmpls-tun) #destination ipv4 unicast 100.20.20.20

Step 5 Set the path optiona and commit.

Example:

RP/0/RPO/CPUO:ios (config-te-gmpls-tun) #path-option 10 no-ero lockdown
RP/0/RPO/CPUO:ios (config-te-gmpls-tun) #commit

What to do next

The following sample shows the MPLS tunnel configuration on the source NCS 1004 node.

RP/0/RP0O/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO

:ios#configure

:ios (config) #mpls traffic-eng

:ios (config-mpls-te) #gmpls optical-uni
rios(config-te-gmpls-uni) #controller optics 0/0/0/6

:ios (config-te-gmpls-cntl) #tunnel-properties

:ios (config-te-gmpls-tun) #tunnel-id 100

:ios (config-te-gmpls-tun) #destination ipv4 unicast 100.20.20.20
:ios (config-te-gmpls-tun) #path-option 10 no-ero lockdown
:ios(config-te-gmpls-tun) #commit

The following sample shows the MPLS tunnel configuration on the destination NCS 1004 node.

RP/0/RP0O/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO

:ios#configure

:ios (config) #mpls traffic-eng

:ios (config-mpls-te) #gmpls optical-uni
rios(config-te-gmpls-uni) #controller optics 0/0/0/6
:ios(config-te-gmpls-uni) #commit

Configure RSVP on the NCS 1004 node

You configure the Resource Reservation Protocol (RSVP) with appropriate signaling timers on the source
and destination NCS 1004 nodes of the tunnel.

Procedure

Step 1 Enter the global configuration mode and the RSVP configuration mode.
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Example:

RP/0/RP0O/CPUO:ios#configure
RP/0/RP0O/CPUO:1i0s (config) #rsvp

Specify the optics controller.

GMPLS UNI for Packet and Optical Integration |

RP/0/RP0/CPUO:i0s (config-rsvp) #controller optics 0/0/0/6

Set the out-of-band signaling refresh interval, in seconds.

RP/0/RP0O/CPUO:ios (config-rsvp-cntl) #signalling refresh out-of-band interval 3600

Step 2

Example:
Step 3

Example:
Step 4

commit.

Example:

Set the maximum number of missed out-of-band signaling refreshes that are allowed before the session is removed, and

RP/0/RP0/CPUO:ios (config-rsvp-cntl) #signalling refresh out-of-band missed 24
RP/0/RPO/CPUO:ios (config-rsvp-cntl) #commit

signalling refresh out-of-band missed mis-count

What to do next

The following sample shows the RSVP configuration on the source NCS 1004 node.

GMPLS UNI tunnel, RSVP, and LMP configuration commands and sample

outputs

Use the show commands in the following table to verify the GMPLS UNI tunnel, RSVP, and LMP

configuration.

Table 2: Show commands

Show command

Description

show mplstraffic-eng link-management optical-uni
controller optics

Displays detailed GMPLS information of a specific
optics controller.

show mplstraffic-eng link-management optical-uni

Displays detailed GMPLS information of all the optics
controllers.

show mplstraffic-eng tunnels

Displays information about tunnels.

show mplstraffic-eng link-management optical-uni
tabular

Displays detailed GMPLS information of all the optics
controllers in tabular format.

show mplstraffic-eng tunnelstabular

Displays information about all the tunnels in tabular
format.

show Imp gmpls optical-uni

Verifies the LMP configuration and state.
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Show command Description

show rsvp neighbors Displays information about RSVP neighbors.

Sample outputs

This sample out of the commnad show mplstraffic-eng link-management optical-uni controller optics
command displays detailed GMPLS information of a specific optics controller.

Mon Jul 1 20:05:27.209 IST
Optical interface: Optics0/0/0/0

Overview:
IM state: Up
Child interface: : IM state Unknown

OLM/LMP state: Up
Optical tunnel state: up
Connection:
Tunnel role: Tail
Tunnel-id: 15, LSP-id 3, Extended tunnel-id 10.105.57.100
Tunnel source: 10.105.57.100, destination: 11.1.1.1
Optical router-ids: Local: 10.105.57.101, Remote: 10.127.60.48
Label source: UNI-N
Upstream label:
Optical label:

Grid : DWDM
Channel spacing : 6.25 GHz
Identifier : 0
Channel Number =277

Downstream label:
Optical label:

Grid : DWDM
Channel spacing : 6.25 GHz
Identifier : 0
Channel Number =277

SRLG discovery: Disabled
SRLG announcement: None
Switching Type: lsc
MTU: 9212
Admission Control:
Upstream: Admitted (LSP ID: 3)
Downstream: Admitted (LSP ID: 3)
OLM/LMP adjacency information:
Adjacency status: Up
Local:
node ID: 10.105.57.101
link interface ID: 10
link ID: 11.1.1.1
Neighbor:
node ID: 10.127.60.48 (VEGA2K-Site-3 48)
link interface ID: 2130706976
link ID: 10.1.1.1
IPCC: Routed to 10.127.60.48
Optical capabilities:
Controller type: DWDM
Channel spacing: 6.25 GHz
Default channel: 0
784 supported channels:
-303, -302, -301, -300, -299, -298, -297, -296
-295, -294, -293, -292, -291, -290, -289, -288
-287, -286, -285, -284, -283, -282, -281, -280
-279, -278, -277, -276, -275, -274, -273, -272
-271, -270, -269, -268, -267, -266, -265, -264
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-263, -262, -261, -260, -259, -258, -257,
-255, -254, -253, -252, =251, =250, =249,
-247, -246, -245, -244, -243, -242, -241,
-239, -238, -237, -236, -235, -234, -233,
-231, -230, -229, -228, =227, -226, -225,
-223, =222, -221, -220, -219, -218, -217,
-215, -214, -213, -212, -211, =210, =209,
-207, -206, -205, -204, -203, -202, -201,
-199, -198, -197, -196, -195, -194, -193,
-191, -190, -189, -188, -187, -186, -185,
-183, -182, -181, -180, -179, -178, -177,
-175, -174, -173, -172, -171, -170, -169,
-167, -166, -165, -164, -163, -162, -161,
-159, -158, -157, -156, -155, -154, -153,
-151, -150, -149, -148, -147, -146, -145,
-143, -142, -141, -140, -139, -138, -137,
-135, -134, -133, -132, -131, -130, -129,
-127, -126, -125, -124, -123, -122, -121,
-119, -118, -117, -116, -115, -114, -113,
-111, -110, -109, -108, -107, -106, -105,
-103, -102, -101, -100, -99, -98, -97, -96
-95, -94, -93, -92, -91, -90, -89, -88
-87, -86, -85, -84, -83, -82, -81, -80
-79, -78, =77, =76, =75, -74, =73, =72
-71, -70, -69, -68, -67, —-66, -65, —64
-63, -62, -61, -60, -59, -58, -57, -56
-55, -54, -53, -52, -51, -50, -49, -48
-47, -46, -45, -44, -43, -42, -41, -40
-39, -38, -37, -36, -35, -34, -33, -32
-31, -30, -29, -28, -27, -26, -25, =24
-23, -22, -21, -20, -19, -18, -17, -16
-15, -14, -13, -12, -11, -10, -9, -8

-7, -6, -5, -4, -3, -2, -1, 0

1, 2, 3, 4, 5, 6, 1, 8

9, 10, 11, 12, 13, 14, 15, 16

17, 18, 19, 20, 21, 22, 23, 24

25, 26, 27, 28, 29, 30, 31, 32

33, 34, 35, 36, 37, 38, 39, 40

41, 42, 43, 44, 45, 46, 47, 48

49, 50, 51, 52, 53, 54, 55, 56

57, 58, 59, 60, 61, 62, 63, 64

65, 66, 67, 68, 69, 70, 71, 72

73, 74, 75, 76, 77, 78, 79, 80

81, 82, 83, 84, 85, 86, 87, 88

89, 90, 91, 92, 93, 94, 95, 96

97, 98, 99, 100, 101, 102, 103, 104

105, 106, 107, 108, 109, 110, 111, 112
113, 114, 115, 116, 117, 118, 119, 120
121, 122, 123, 124, 125, 126, 127, 128
129, 130, 131, 132, 133, 134, 135, 136
137, 138, 139, 140, 141, 142, 143, 144
145, 146, 147, 148, 149, 150, 151, 152
153, 154, 155, 156, 157, 158, 159, 160
161, 162, 163, 164, 165, 166, 167, 168
169, 170, 171, 172, 173, 174, 175, 176
177, 178, 179, 180, 181, 182, 183, 184
185, 186, 187, 188, 189, 190, 191, 192
193, 194, 195, 196, 197, 198, 199, 200
201, 202, 203, 204, 205, 206, 207, 208
209, 210, 211, 212, 213, 214, 215, 216
217, 218, 219, 220, 221, 222, 223, 224
225, 226, 227, 228, 229, 230, 231, 232
233, 234, 235, 236, 237, 238, 239, 240
241, 242, 243, 244, 245, 246, 247, 248
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-256
-248
-240
-232
=224
-216
-208
-200
-192
-184
-176
-168
-160
-152
-144
-136
-128
-120
-112
-104
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249,
257,
265,
273,
281,
289,
297,
305,
313,
321,
329,
337,
345,
353,
361,
369,
3717,
385,
393,
401,
4009,
417,
425,
433,
441,
449,
457,
465, 466, 467,
473, 474, 475,

Controller SRLGs
None

250,
258,
266,
274,
282,
290,
298,
306,
314,
322,
330,
338,
346,
354,
362,
370,
378,
386,
394,
402,
410,
418,
426,
434,
442,
450,
458,

251,
259,
267,
275,
283,
291,
299,
307,
315,
323,
331,
339,
347,
355,
363,
371,
379,
387,
395,
403,
411,
419,
427,
435,
443,
451,
459,

252,
260,
268,
276,
284,
292,
300,
308,
316,
324,
332,
340,
348,
356,
364,
372,
380,
388,
396,
404,
412,
420,
428,
436,
444,
452,
460,
468,
476,

GMPLS UNI tunnel, RSVP, and LMP configuration commands and sample outputs .

256
264
272
280
288
296
304
312
320
328
336
344
352
360
368
376
384
392
400
408
416
424
432
440
448
456
464
472
480

253,
261,
269,
277,
285,
293,
301,
309,
317,
325,
333,
341,
349,
357,
365,
373,
381,
389,
397,
405,
413,
421,
429,
437,
445,
453,
461,
469,
477,

254,
262,
270,
278,
286,
294,
302,
310,
318,
326,
334,
342,
350,
358,
366,
374,
382,
390,
398,
406,
414,
422,
430,
438,
446,
454,
162,
470,
478,

255,
263,
271,
279,
287,
295,
303,
311,
319,
327,
335,
343,
351,
359,
367,
375,
383,
391,
399,
407,
415,
423,
431,
439,
447,
455,
463,
471,
479,

show mpls traffic-eng link-management optical-uni

Displays detailed GMPLS information of all the optics controllers. MPLS tunnels are not created when the
optics controller is in the shutdown state. The state is shown as "Admin down". Run the no shutdown command
under the optics controller to initiate the tunnel creation.

Mon Jul 1 20:00:42.108 IST
System Information:

Optical Links Count: 1 (Maximum Links Supported 100)

Optical interface: Optics0/0/0/0
Overview:
IM state: Up

Child interface:

OLM/LMP state: Up

Optical tunnel state:
Connection:

Tunnel role: Tail

Tunnel-id: 15, LSP-id 3, Extended tunnel-id 10.105.57.100

Tunnel source: 10.105.57.100, destination: 11.1.1.1

Optical router-ids: Local: 10.105.57.101, Remote: 10.127.60.48

Label source: UNI-N

Upstream label:

Optical label:

IM state Unknown

up

Grid

Channel spacing

Identifier
Channel Number

Downstream label:

Optical label:

DWDM
6.25 GHz
0

=277
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Grid : DWDM
Channel spacing : 6.25 GHz
Identifier : 0
Channel Number : =277

SRLG discovery: Disabled
SRLG announcement: None
Switching Type: lsc
MTU: 9212
Admission Control:
Upstream: Admitted (LSP ID: 3)
Downstream: Admitted (LSP ID: 3)
OLM/LMP adjacency information:
Adjacency status: Up
Local:
node ID: 10.105.57.101
link interface ID: 10
link ID: 11.1.1.1
Neighbor:
node ID: 10.127.60.48 (VEGA2K-Site-3_48)
link interface ID: 2130706976
link ID: 10.1.1.1
IPCC: Routed to 10.127.60.48
Optical capabilities:
Controller type: DWDM
Channel spacing: 6.25 GHz
Default channel: 0
784 supported channels:
-303, -302, -301, -300, =299, -298, -297, -296
-295, -294, -293, -292, -291, -290, -289, -288
-287, -286, -285, -284, -283, -282, -281, -280
-279, -278, =277, =276, =275, =274, =273, =272
-271, =270, -269, -268, -267, -266, -265, -264
-263, -262, -261, -260, -259, -258, -257, -256
-255, -254, -253, -252, -251, -250, -249, -248
-247, -246, -245, -244, -243, =242, -241, -240
-239, -238, -237, -236, -235, -234, -233, -232
-231, -230, -229, -228, =227, =226, =225, =224
-223, -222, =221, =220, =219, -218, -217, =216
-215, -214, -213, -212, =-211, =210, -209, -208
-207, -206, -205, -204, -203, -202, -201, -200
-199, -198, -197, -196, -195, -194, -193, -192
-191, -190, -189, -188, -187, -186, -185, -184
-183, -182, -181, -180, -179, -178, -177, -176
-175, -174, -173, -172, -171, -170, -169, -168
-167, -166, -165, -1l64, -163, -162, -161, -160
-159, -158, -157, -156, -155, -154, -153, -152
-151, -150, -149, -148, -147, -146, -145, -144
-143, -142, -141, -140, -139, -138, -137, -136
-135, -134, -133, -132, -131, -130, -129, -128
-127, -126, -125, -124, -123, -122, -121, -120
-119, -118, -117, -116, -115, -114, -113, -112
-111, -110, -109, -108, -107, -106, -105, -104
-103, -102, -101, -100, =99, -98, -97, -96
-95, -94, -93, -92, -91, -90, -89, -88
-87, -86, -85, -84, -83, -82, -81, -80
-79, -78, -77, -76, -15, -74, -73, =72
-71, =70, -69, -68, -67, -66, -65, -64
-63, -62, -61, -60, -59, -58, -57, -56
-55, -54, -53, -52, -51, -50, -49, -48
-47, -46, -45, -44, -43, -42, -41, -40
-39, -38, -37, -36, -35, -34, -33, -32
-31, -30, -29, -28, -27, -26, =25, -24
-23, -22, -21, -20, -19, -18, -17, -16
-15, -14, -13, -12, -11, -10, -9, -8
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=7, _61 -5, -4, _31 _21
1, 2, 3, 4, 5, 6, 7, 8

GMPLS UNI tunnel, RSVP, and LMP configuration commands and sample outputs .

-1,

9, 10, 11, 12, 13, 14, 15,

17, 18, 19, 20, 21, 22,
25, 26, 27, 28, 29, 30,
33, 34, 35, 36, 37, 38,
41, 42, 43, 44, 45, 46,
49, 50, 51, 52, 53, 54,
57, 58, 59, 60, 61, 62,
65, 66, 67, 68, 69, 70,
73, 74, 75, 76, 17, 78,
81, 82, 83, 84, 85, 86,
89, 90, 91, 92, 93, 94,

23,
31,
39,
47,
55,
63,
71,
79,
87,
95,

97, 98, 99, 100, 101, 102,
110,
118,
126,
134,
142,
150,
158,
166,
174,
182,
190,
198,
206,
214,
222,
230,
238,
246,
254,
262,
270,
278,
286,
294,
302,
310,
318,
326,
334,
342,
350,
358,
366,
374,
382,
390,
398,
406,
414,
422,
430,
438,
446,
454,
162,
470,
478,

105, 106, 107, 108, 109,
113, 114, 115, 116, 117,
121, 122, 123, 124, 125,
129, 130, 131, 132, 133,
137, 138, 139, 140, 141,
145, 146, 147, 148, 149,
153, 154, 155, 156, 157,
161, 162, 163, 164, 165,
169, 170, 171, 172, 173,
177, 178, 179, 180, 181,
185, 186, 187, 188, 189,
193, 194, 195, 196, 197,
201, 202, 203, 204, 205,
209, 210, 211, 212, 213,
217, 218, 219, 220, 221,
225, 226, 227, 228, 229,
233, 234, 235, 236, 237,
241, 242, 243, 244, 245,
249, 250, 251, 252, 253,
257, 258, 259, 260, 261,
265, 266, 267, 268, 269,
273, 274, 275, 276, 2717,
281, 282, 283, 284, 285,
289, 290, 291, 292, 293,
297, 298, 299, 300, 301,
305, 306, 307, 308, 309,
313, 314, 315, 316, 317,
321, 322, 323, 324, 325,
329, 330, 331, 332, 333,
337, 338, 339, 340, 341,
345, 346, 347, 348, 349,
353, 354, 355, 356, 357,
361, 362, 363, 364, 365,
369, 370, 371, 372, 373,
377, 378, 379, 380, 381,
385, 386, 387, 388, 389,
393, 394, 395, 396, 397,
401, 402, 403, 404, 405,
409, 410, 411, 412, 413,
417, 418, 419, 420, 421,
425, 426, 427, 428, 429,
433, 434, 435, 436, 437,
441, 442, 443, 444, 445,
449, 450, 451, 452, 453,
457, 458, 459, 460, 461,
465, 466, 467, 468, 469,
473, 474, 475, 476, 477,
Controller SRLGs
None

0

16
24
32
40
48
56
64
72
80
88
96

103,
111,
119,
127,
135,
143,
151,
159,
167,
175,
183,
191,
199,
207,
215,
223,
231,
239,
247,
255,
263,
271,
279,
287,
295,
303,
311,
319,
327,
335,
343,
351,
359,
367,
375,
383,
391,
399,
407,
415,
423,
431,
439,
447,
455,
463,
471,
479,

104

112
120
128
136
144
152
160
168
176
184
192
200
208
216
224
232
240
248
256
264
272
280
288
296
304
312
320
328
336
344
352
360
368
376
384
392
400
408
416
424
432
440
448
456
464
472
480
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show mpls traffic-eng link-management optical-uni tabular

GMPLS UNI for Packet and Optical Integration |

Displays detailed GMPLS information of all the optics controllers in tabular format.

Mon Jul 1 15:10:50.472 IST

System Information:
Optical Links Count: 4

(Maximum Links Supported 100)

GMPLS tunnel

role

tun-id

state

up
up
up

State LMP

Interface Admin Oper adjacency
Op0/0/0/0 up up up
Op0/0/0/1 up up up
Op0/1/0/0 up up up
Op0/1/0/1 up up up

show mpls traffic-eng tunnels

Displays information about tunnels.

Mon Jul 1 15:03:58.490 IST

LSP Tunnel 10.105.57.100 15 [5]
Tunnel Name: ckt0/0/0/0 Tunnel Role:
Upstream label:

Optical label:

Grid DWDM

Channel spacing 6.25 GHz

Identifier : 0

Channel Number =277
Downstream label:

Optical label:

Grid DWDM

Channel spacing 6.25 GHz

Identifier : 0

Channel Number =277

Signalling Info:
Src 10.105.57.100 Dst 11.1.1.1,
Router-IDs: upstream 10.127.60.48
local
Priority: 7 7
SRLGs: not collected
Path Info:
Incoming Address:
Incoming:
Explicit Route:
No ERO

10.1.1.1

Route Exclusions:
No XRO

Record Route: Disabled

Tspec: avg rate=4294967033 kbits,

Session Attributes: Local Prot:

Resv Info: None

Record Route: Disabled

Fspec: avg rate=4294967033 kbits,
Displayed 0 (of 0) heads, 0 (of 0)
Displayed 0 up, 0 down, 0 recovering,

show rsvp neighbors

Displays information about RSVP neighbors.
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is signalled,

10.105.57.101

Tun ID 15,

Not Set,

midpoints, 1
0 recovered heads

Tun Inst 5,

burst=1000 bytes,
Node Prot:

burst=1000 bytes,
(of 1)

up

Signaling State: up

Ext ID 10.105.57.100

peak rate=4294967033 kbits
Not Set, BW Prot: Not Set

peak rate=4294967033 kbits

tails
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Mon Jul 1 14:58:48.888 IST
Global Neighbor: 10.127.60.48
Interface Neighbor Interface

10.127.60.48 MgmtEthO/RP0O/CPUO/0

show Imp gmpls optical-uni

Verifies the LMP configuration and state.

Mon Jul 1 14:55:35.492 IST
GMPLS Optical-UNI LMP Router ID: 10.105.57.101

LMP Neighbor
Name: ncslk, IP: 10.127.60.48, Owner: GMPLS Optical-UNI
LMP: Disabled

IPCC ID: 1, State Up

LMP UDP port: 701

Known via : Configuration

Type : Routed

Destination IP : 10.127.60.48

Source IP : 10.105.57.101

Interface I/F | Lcl Interface ID | Lcl Link ID | Interface LMP state
—————————————————————— B ettt e e et

Optics0/1/0/1 7 11.5.5.5 Up
Optics0/1/0/0 6 11.4.4.4 Up
Optics0/0/0/1 11 11.3.3.3 Up
Optics0/0/0/0 10 11.1.1.1 Up

GMPLS UNI tunnel troubleshooting commands and resolutions

Recommended show commands for troubleshooting GMPL S UNI tunnels
Collect and analyze the output of the following commands for any software issues on the GMPLS UNI tunnel.

» show tech-support mplstraffic-eng file filename

» show tech-support mplsrsvp filefilename

« show Imp clients

« show rsvp neighbors

« show mplstraffic-eng link-management optical-uni controller optics Rack/Sot/Instance/Port

+ show mplstraffic-eng tunnels tunnel-id

Table 3: GMPLS UNI tunnel issues and recommended resolutions

Problem Solution

When the NCS 2000 node cannot route the Dense | As a super user, collect and analyze the diagnostic
Wavelength Division Multiplexing (DWDM) information by entering the following address in the
wavelength to the destination, it displays a generic | browser:

error message: "No Route to destination". ) . .
http://ip-address-of-head-node/diagnostics/wson

GMPLS UNI for Packet and Optical Integration [JJjj



GMPLS UNI for Packet and Optical Integration |
. Related information for GMPLS UNI

Related information for GMPLS UNI

Refer to the following resources for additional information about GMPLS UNI.
* GMPLS UNI commands: Cisco IOS XR MPLS Command Reference.

* GMPLS Restoration and Reversion.
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http://www.cisco.com/c/en/us/td/docs/routers/crs/software/crs_r6-1/mpls/command/reference/b-mpls-cr-crs-61x/b-mpls-cr-53xcrs_chapter_0110.html
https://www.cisco.com/c/en/us/td/docs/optical/r11/ncs/network-config/b_ncs_network_configuration-R11/b_ncs_network_configuration_chapter_0100.html
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